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Abstract

If you want to code Amiga AGA demos, are able to program, but
don't know how to get started on the Amiga, then this document is for
you. Also if you are already more experienced on Amiga and want to learn
about how we do our demos. This document describes how to set up and
use the Haujobb Amiga Framework on Amiga and PC. The framework
allows for prototyping, debugging, and timing e�ects natively on the PC
(currently Windows mainly, but Mac and Linux should work as well); and
then cross-compiling for the Amiga. We have used these exact codes and
work�ows for our demo Beam Riders; and prior versions for Last Train to

Danzig and Prototype 1.
This document guides you through setting up the required components

in small steps with immediate incentives � leading up to a complete ex-
ample demo with timing done via the Rocket editor. To get started, �rst
read the guide to the document section to �nd your way around. Then
go and make a demo about it!
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Part I

Setup

The Haujobb Amiga Framework facilitates modern Amiga demo making on
several levels.

On its lowest level, WickedOS, it provides with you with an API for assembly-
level access to over 20 di�erent chunky to planar based screenmodes, several
music replayers, and interrupt hooks. You can choose from using a multi-
tasking-friendly hardware abstraction layer, or a traditional multi-tasking-killer
mode. WickedOS has been used in a number of our Amiga demos, ranging from
Mnemonics to Beam Riders . By default it targets �todays� 68060 AGA demos,
i.e. having an FPU and at least a 68020 or better CPU in the target machine.

On a higher level, the framework allows you to mix assembler and C-code.
Furthermore, it provides you with a reimplementation of the WickedOS-API in
Qt, This allows for developing and debugging e�ects natively on the PC, before
cross-compiling (and further optimizing) them for the Amiga.

1 Guide to the do cument

This document tries to document to entire framework, which includes working
on the PC and well as on the Amiga (with di�erent tools).

If you just wanted to have a quick start on your PC, read the Quickstart
section on the following page.

If you also wanted to set up assembler, C-compiler and linker on the Amiga,
start reading at that chapter on the next page. Please note that albeit those
tools work perfectly �ne on Amiga, we are not supporting them fully with our
make�les.

If you were really curious and also wanted to play around with WickedOS us-
ing Asm-One and Devpac, you could read the corresponding section on page 39
in the annex.

In any case, once you installed the assembler, compiler, linker and make
tools, you should �rst check out the Hello World example on page 12, before
following the rest of the examples, which are described in Part II of this docu-
ment, starting on page 21.

1.1 Resources

The complete sources are available at https://github.com/leifo/haujobb-amiga.
The documentation is hosted at http://www.dig-id.de/amiga/framework/, PDF-
version at http://www.dig-id.de/amiga/framework/haf.pdf.
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1.2 Quick st art (TL;DR)

The Haujobb Amiga Framework supports development of Amiga demos on PC,
and then cross-compiling them for the Amiga.You probably didn't want to com-
pile and assemble on the Amiga anyway, so you just:

� set up the vbcc cross-compiler for Windows using Install-VBCC.exe (to
c:\vbcc), as described on page 11

� you could then cd to the root folder haujobb-amiga and type make
to build the whole Amiga side from scratch

� set up a shared folder on your PC or NAS that could be reached from
your real or emulated Amiga, as described on page 9

� installed Visual Studio, at least 2010, but probably the latest 2017 Com-
munity edition, as described on page 16

� installed Qt5, Qt Creator, and cdb debugger support, as described on
page 16

� and then double-checked that compiler, debugger, and Qt version were
correctly set up as a kit , as described on page 17

This is all that needed to be done, so you could now open our supplied example
project �les (*.pro) in the /demo folder and start making Amiga demos on PC.
If you �nd any issues, please report them on GitHub.

Enjoy!

2 Assembler and Li nker Setup

Traditionally, many Amiga-demos were made using ASM-One, or one of its
derivates. I have personally worked with ASM-One v1.29 for many years, and
demos like Mnemonics were made almost exclusively with that assembler, while
other parts relied on genam from the Devpac 3.04 package. To honor that
tradition, WickedOS stays fully compatible with ASM-One and Devpac. But,
more importantly, it can also be used with tools like vasm and vlink, both
natively on the Amiga, and for cross-compiling on the PC.

This setup chapter will take you on a quick tour through the di�erent com-
ponents that are required to get you up and running step by step.

To get started, grab the release archive of our framework from GitHub at
https://github.com/leifo/haujobb-amiga.

2.1 Includes from NDK

First of all, you need to have the assembler include-�les available at �INCLUDES:�.
WickedOS doesn't need the latest features of AmigaOS, so it is likely to work
with the includes that you might already have. If not, do as follows.
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Obtain a copy of the latest AmigaOS Native Developer Kit (NDK). At the
time of writing this was version 3.9 and it was still available at www.haage-
partner.de/download/AmigaOS/NDK39.lha

1. Unpack the archive on your Amiga

2. Assign �INCLUDES:� <whereYouUnpackedIt>/Include/include_i

3. List includes:hardware/custom.i (should list a �le, mine is 3045 bytes long)

4. Consider putting the assign from line 2 into s:user-startup (optional, but
you must provide the assign to INCLUDES: if you plan to assemble Wicke-
dOS on Amiga).

2.2 vasm and vlink

We can now use vasm to assemble the WickedOS source into a linkable bi-
nary object (.o) �le, and then link that into an executable �le using vlink .
These portable command-line tools are at the core of our strategy for cross-
development, together with vmake and vbcc, which will be covered later in this
document.

The project homepages are at http://sun.hasenbraten.de/vasm/and
http://sun.hasenbraten.de/vlink/. You can get the binaries, sources, as well

as complete documentation for both tools at their respective homepages.
The supplied WickedOS source assembles out of the box on Amiga and PC.

The following sections show you how to do it.
To assembe on the Amiga, get the latest release binaries from

� http://sun.hasenbraten.de/vasm/bin/rel/vasmm68k_mot_os3.lha

� and http://sun.hasenbraten.de/vlink/bin/rel/vlink_AmigaM68k.lha

Copy the contained �les vasmm68k_mot and vlink to your path (e.g. to �C:�).
Con�rm that they are working by typing:

� vlink -v

� vasmm68k_mot

The output version numbers should somehow match those that are mentioned
on the project homepages. Note that vasm is not only portable, i.e. ready to
make work on di�erent plattforms, but also retargetable, i.e. able to assemble
sources for di�erent target CPUs with di�erent syntax modules. Shortcodes
for the latter two are automatically appended to the binary executable name.
Although many di�erent versions of vasm exist, we are only interested in the
68k_mot version. If you are like me and like shorter names, you can add �alias
vasm vasmm68k_mot� to your s:user-startup to make your life a little bit easier
once in a while.
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Figure 2.1: Wostest assembled on Amiga, output

2.3 Example: Wostest

With vasm and vlink in place, you can already assemble, link and execute the
built-in example like this:

1. cd WOS:

2. execute buildwostest.bat

3. wostest

This procedure should build and run an example screen. See the screenshot for
a typical output of the shell and of wostest .

vasm and vlink are called from buildwostest.bat, which contains only two
lines. Let's look at them in more detail:

vasmm68k_m ot - Fhunk -m68020 -m68882 wos_v1.6 3.s -o wostest.o

-Ic:/vbcc/ NDK39/Include/includ e_i -DWTEST

vlink wostest. o - o wo stest

The vasm-line speci�es a number of things about our source and target binary
via these parameters:

� -F: the output format should be (Amiga) hunk

� -m68020/m68882: the source contains 68020 CPU and 68882 FPU com-
mands (this de�nes the base-level and is also okay if we really want to
target 68060)

� -o: the assembled �le should be written to a linkable object named wostest.o

� -D: De�ne a �ag (here �WTEST�, which causes the conditional-assembly
of the built-in example)

� -I: additional Include path at �c:/vbcc/targets/NDK39/Include/include_i�
(as created by the Windows installer, c.f. on page 11)
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Figure 2.2: Wostest assembled on PC

� Note that this path is searched �rst, but not found on Amiga, since
it is a PC-style path, and thus disregarded silently.

� vasm thus falls back to using the �incdir INCLUDES:� directives that
are contained in the source.

� if you preferred, you could actually remove the assign INCLUDES:
and point to the corresponding directory via the -I parameter.

Finally, the vlink-line takes the output-�le generated by vasm, wostest.o, and
turns it into an executable �le, wostest .

2.4 Assembling on PC

Windows binaries of vasm, vlink and make are shipped together with the vbcc-
compiler which can be obtained from http://sun.hasenbraten.de/vbcc/

Download and run Install-VBCC.exe, as decribed on page 11 in more detail.
Please skip to that page. Then come back and con�rm that the tools are working
by opening a command prompt and typing:

� vlink -v

� vasmm68k_mot

With vasmm68k_mot and vlink in place, you can then just:

1. cd <to the directory where you unpacked W ickedOS on PC> (here: t:\wos)

2. type �buildwostest.bat� to cross-assemble and link wostest on the PC

Note that the binary output produced on the PC is exactly the same as on the
Amiga, of course. Also note that this worked in a fraction of the time that it
took on the Amiga. Yes, it was really that fast . Welcome to Modern Amiga
Demo Cross-Development!
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2.5 Shared Folders b etween A miga and PC

Now that you cross-compiled an Amiga executable blazingly fast on your PC,
you wouldn't want to waste any time getting it onto your Amiga for testing it,
would you? So manual �le-copying via FTP, CF-cards, or by other means is not
going to be fast enough for quick turn-around times. Your ideal setup depends
on whether you want to work with emulated or real Amigas, or both.

Emulators like WinUAE allow adding a folder from the host-computer as a
volume on the emulated Amiga. Do yourself a favour and use this feature!

I personally mounted a volume �WIP:� (as in Work In Progress) from a folder
that I mounted from a Network Attached Storage (NAS, a Synology here) on
the PC. This is because...

Real Amigas cannot just mount your Windows folders. NAS folders, on
the other hand, are made to be mountable, and can also easily be mounted on
Amigas that have:

� some Fast-RAM

� a TCP/IP stack, like AmiTCP, Genesis, Miami, or Roadshow

� a SMB �le system client like smbfs (try Aminet, although the version 1.74
hosted there is currently horribly outdated)

� I am using Roadshow and just had to add the following line to
s:Network-Startup

smbfs domain=w orkgroup user=username pass word=password

volume=NAS serv ice=//diskstation/fi les/amiga

PC-Ramdisks are a fact. Yes, they do exist! Even though they are not
shipped as part of the Windows operating system, like on Amiga, you can easily
download and install very powerful third-party components. And PC-based
Ramdisks are just as useful as they have always been on Amigas. This is what
I did:

1. Download and install ImDisk Virtual Disk Driver

2. Con�gure a Drive Letter �T:� with a 2 GB RamDisk using File System
�NTFS�

(a) check: �Allocate Memory Dynamically�, �Launch at Windows Startup�

(b) uncheck: �Create TEMP Folder�

3. Mount that folder as �PCT:� in WinUAE (very useful for quick data ex-
change, esp. downloads)
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3 Compiler Se tu p

When planning to develop Amiga software with the C programming language,
there are a number of C-Compilers to choose from. Most notably they are:

� SAS/C, which is the Amiga standard programming environment (com-
mercial and deprecated)

� GCC, which is the cross-plattform standard (free and open source)

� Storm C, an Amiga programming environment based on an old version of
GCC (commercial)

� DICE, which was a popular and inexpensive Amiga programming envi-
ronment (recently open sourced)

� vbcc, which is an actively maintained cross-plattform compiler (free and
open source)

As we were looking for a cross-compiling solution, SAS/C, Storm C and DICE
were no options. They are also neither free and open source, nor actively main-
tained, which was our second selection-criteria. This left us to decide between
GCC and vbcc. At the time when we made our decision in 2009/2010, the
Amiga-port of GCC was lacking behind in version numbers, while vbcc was the
relatively new thing that was used by several Amiga-coders, and personally rec-
ommended by Kalms of TBL. It also allows for writing inline-assembly in the
familiar Motoral syntax, rather than the more alien GCC Assembler syntax.

Moreover, vbcc is designed to work in combination with vasm and vlink
from the same authors. The maintainer of the Amiga bindings, Frank Wille, is
one of the most experienced and longest standing developers of quality Amiga
development tools, ranging back to at least 1991 (with his PhxAssand PxhLnk).
This long-term experience and continued commitment ensures �rst class Amiga
support.

Hence, we decided to use vbcc as our C-compiler. The vbcc project home-
page is located at http://sun.hasenbraten.de/vbcc/. There you can get the
binaries, targets, sources, and complete documentation.

3.1 vb cc setup on Amiga

Installation on Amiga is easy. Citing the vbcc download instructions:

You need to pick the appropriate binary archive for your host
platform. Then you can add as many target archives as you need. [..]
Install the binary archive �rst, using the provided Amiga installer,
then add the targets.

So, download and install:

1. AmigaOS 2.x/3.x 68020+ binaries
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2. Compiler target AmigaOS 2.x/3.x M680x0

The archives contain standard Amiga Installer scripts. Run them. Then test if
the following commands are available:

1. vc

2. vbccm68k

The former is a frontend for the latter and is very handy, if you are planning to
use the C-compiler on the Amiga..

3.2 vb cc setup on PC

Installation on PC is even easier. Basically, just download and install a single
�le from the vbcc homepage. But be aware that the download is falsely reported
to be a infected by malware by several virus scanners! Therefore:

1. Disable your virus-checker (optional)

2. Download and install Install-VBCC.exe with these settings

(a) Leave �Default compiler target� as Ami gaO S 2.0

(b) Change path (below) to C:\vbcc

Figure 3.1: VBCC Installer for Windows

3. Enable your virus-checker again. If your were curious about this installer,
you could:
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(a) check the sources at GitHub

(b) follow the thread Windows installer for VBCC tool chain at the En-
glish Amiga Board

(c) or believe us that it is �ne.

The good news is that you are already done! Open a new command prompt
and test that the following commands are available:

1. vc

2. vbccm68k

3. vasmm68k_mot

4. vlink

5. make

3.3 Example: Hello world

Let's compile our �rst C-source with this setup! The following procedure should
work on the Amiga aas well as on the PC side.

1. cd to the /demo/helloworld folder

2. vc hello.c

(a) this should generate an Amiga executable �a.out�

(b) alternatively provide a �lename with: vc hello.c -o hello

3. Run the freshly compiled executable on Amiga.

For completeness, this is the full source of hello.c

/* hello world, nonam e, 23.10.18

compile with:

- "vc hello.c" (comp iles to file a.out)

- or "vc +aos68k hello.c -o hel lo" (being more explicit about what we want)

- or "vc +aos68k hello.c -o hel lo -v" (to see commands as called by vc)

- or "make" (using makef ile)

*/

#include <stdi o.h>

int main(int argc , ch ar **argv)

{

int i;

if (argc==1)

{
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/* no args */

printf("Hel lo, world!\n"); /* argv[0] is always the fil ename */

printf("Cal led from filename: %s\n", argv[0] );

}else{

/* arguments given , s tart at argv[1] */

printf("Hel lo");

for (i=1; i<argc; i++ )

{

printf(", %s" ,argv[i]);

}

printf("!\n ");

}

return 0;

}

This is slightly extended hello world that also makes use of the provided argu-
ments (i.e. argc and argv). You can also build the binary by executing build.bat.
This example also comes with a simple make�le. But in order to build it from
there, you �rst have to install make itself.

4 GNU make

While using batch-�les for scripting repetetive tasks is useful, you are quickly
hitting the roof with that approach. Which �les need to be built, and how?
This is where make�les and make come into play. They coordinate the software
build process in a structured way. Required tools, source-�les, and libraries are
listed in the make�le. Based on the rules that are also noted in the make�le,
the make-tool then coordinates the build-process, i.e. turning source-code into
an executable �le.

We are using GNUmake for building the Amiga target, as it is a free standard
tool that is available on both Amiga and current plattforms. It is your choice
to install it on Amiga and/or PC. The forthfollowing test should run on both
platforms.

4.1 Con�guring make on Amiga

1. Get a native Amiga binary from: http://aminet.net/package/dev/c/make-
3.75-bin and put it to your path

(a) Please note that the v3.75 from Aminet is in fact a v3.74 ported
natively for Amiga. The author just bumped the version number for
his e�orts.

(b) Open a newshell and type �make -v� to check that make is working

i. it should show you its version number.
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ii. In case you get a stack over�ow warning type �stack 20000� and
try again

4.2 Con�guring make on PC

1. Make is bundled and installed with Install-VBCC.exe, as described on
page 11 (v4.2.90 at the time of writing). Thus you should have already
installed it.

(a) This is the preferred version

(b) Alternatively, older Windows binaries can be obtained from:
http://gnuwin32.sourceforge.net/packages/make.htm

2. Open a command prompt and type �make -v� to check that it is working

(a) make should show you its version number.

4.3 Building the WickedOS C2P-converters

We are aiming to use make on both Amiga and PC. Test that it works for you
in two steps:

1. Use it to assemble a bunch of real world assembler �les with a given
make�le

(a) cd to /sub

(b) make

This should call vasm on about two dozen assembly-�les from the /chunky
subfolder and generate the same number of *.bin �les. These �les are the actual
chunky to planar (C2P) converters for WickedOS' di�erent screenmodes. If the
distribution archive came only with one bin-�le (for screenmode #1, as used in
the initial example), you have now enabled the rest of them. Congratulations,
well done!

4.4 Cleaning wit h rm

After work comes the clean-up! For make this is �make clean� which usually
deletes a bunch of assembled or compiled binary object �les and needs a delete
command in order to work. Unfortunately, these delete commands di�er be-
tween operating systems, not only by name, but also by syntax. In order to
keep at least a somehow coherent structure, we de�ne as per convention that a
command �rm� should be reachable and work like rm from GNU coreutils.
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4.4.1 On Amiga

Just add another line to s:user-startup: �alias rm delete�. Please note that this
is not ideal but will work reasonably well for small projects, as long as the
command-line does not get too long. Unfortunately, the command-line of the
C2P-converter example with over 20 entries is already exceeding those limits.
Mea culpa!

4.4.2 On PC

Windows del is not good enough for our purposes! Therefore we are using rm
from GNU coreutils, a.k.a. �leutils.

1. Get the latest binaries from
http://gnuwin32.sourceforge.net/packages/coreutils.htm

(a) either choose the setup �le, or just the binary.zip

2. At your discretion, install all the tools, or just copy rm.exe from the bin-
folder in the zip-�le to your path

(a) it is suggested to copy rm to c:\vbcc\bin

(b) in case you choose the �le from the zip-�le, add missing dependencies
from coreutils-dep-zip

3. Open a command prompt and type �rm --help� to check if it is working

4. Finally, try it in combination with make

(a) cd to the /sub directory again

(b) type �make� and it should tell you �Nothing to be done for `all'� which
means that all assembled �led were up-to-date.

(c) type �make clean� to remove those �les

(d) type �make� again and see it rebuild.

This concludes the setup of the Amiga-oriented tools.

5 PC-Prototyping Environment

A large part of the productivity-bene�ts of our toolchain stem from the use
of a native PC-build while prototyping the e�ects and editing the demo. This
takes cross-compilation out of the picture for a period of time and allows you
to focus on getting something on screen, debugging it, and then making it
look nice before focussing again on making it all run smoothly on the Amiga.
It also allows you to exploit the PC-hardware that you own anyway for your
own sanity, e.g. use your big monitor wisely and �ll it with a modern IDE
with syntax-coloring, code-completion, code-navigation, project support, and
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of course debugging facilities. And run all of this natively on your modern
multi-core CPU to save time and keep you in the �ow.

For this to work you need a compiler, an IDE, and a debugger. While
in theory these components would all be included in the popular Microsoft
Visual Studio, we have blended it in our toolchain with QtCreator as the IDE
component. While this was mainly a simple personal preference for a nice IDE
that can work with di�erent compilers, it also kept our toolchain itself plattform
independant! QtCreator is available for Windows, macOS, and Linux. For the
latter two, you would be able to set it up with gcc. For Windows, you best use
it in combination with Microsoft's compiler.

5.1 Visual Studio

Let's start with installing Microsoft Visual Studio (MSVC), which comes in
many di�erent versions over the years (see table). The oldest one that we have
personally tested is 2010. If you already have Visual Studio installed in a least
that version, you can skip this section.

Visual Studio 2010 2012 2013 2015 2017

Pro OK not tested OK not tested not tested
Community - - not tested OK OK

Table 1: Supported Microsoft Visual Studio versions

While Visual Studio was, and still is, a full-price commercial product, Mi-
crosoft has launched a number of free (as in beer) editions over the years. The
Express edition introduced in 2005 has long since been discontinued and is now
superseded by the Community edition. Visual Studio Community 2017 will
work well for us. Please download it from https://visualstudio.microsoft.com
and then install it on your Windows machine.

With Visual Studio Community 2017, please also install the missing standard
headers by selecting Windows Universal CRT SDK under Individual Compo-
nents -> Compiler, Buildtools and Runtimes , as described (9.1).

5.2 Qt Creator

Now let't install Qt and Qt Creator. The Haujobb Amiga Framework is known
to work with Qt4 and Visual Studio 2010 as the minimum supported versions. If
you haven't got Qt installed already, head over to https://www.qt.io/download,
get the Open Source edition installer for Qt5, and run it.

It features many di�erent options, we don't need all of them. Just install the
latest available Qt 5.x.y release, as well as QtCreator and CDB support from
the tools section (see �gure 5.1).

Please note that the version numbers in the �gure will change quickly and
are already outdated at the time of writing. The �gure also shows a setup
wizard that was run on a machine with MSVC 2015 32-bit. You will need to
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Figure 5.1: Required Components from Qt Open Source Installer

pick the version that �ts your installed compiler. It is your choice, to install
32-bit or 64-bit version (if available). The default path for installation if C:\Qt.

The o�cial documentation for Qt Creator is at http://doc.qt.io/qtcreator/.

5.3 Debugger (CDB)

If you want to debug your C-programs in Qt Creator, you need to setup the
CDB debugger. The o�cial documentation for this is here. It boils down
to downloading the Windows SDK from https://developer.microsoft.com/de-
de/windows/downloads/windows-10-sdk. Then run the installer and uncheck
everything except �Debugging Tools for Windows� (see �gure 5.2).

5.4 Kit Setup

In Qt Creator, combinations of compiler, debugger, Qt version, and a few other
things are called a kit .

We need such a kit in order to work with our supplied project �les (stars.pro,
etc.). The full Qt doc for this is at http://doc.qt.io/qtcreator/creator-con�guring-
projects.html.

When you installed compiler, debugger and Qt as described above, go to
menu Tools->Options. The presented options windows should resemble �gure
5.3 (note that it has been taken with an older Windows SDK installed).

Select Kits on the left pane. Then:

� check under Qt Versions that your installed Qt Version got auto-detected.
If not, con�gure it manually.

� check under Debuggers that two versions of cdb.exe (32/64-bit) were found
in the Windows Kits folder.
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Figure 5.2: Debugging Tools for Windows from Windows SDK

� check under Compilers that the Visual C++ compiler was correctly auto-
detected. Note that the list will usually show several versions ending on
something like �(amd64_x86)� meaning that this would be running on
a 64-bit machine and generating code for a 32-bit machine. It usually
doesn't matter to our framework if you are selecting a 32-bit version or
not, as we are not going anywhere near the 32-bit limits, anyway.

� check under Kits that you have an auto-detected kit comprising of a Qt
Version , a Debugger , and a Compiler .

� close the Options window, and you should be able to build & run, as well
as to debug.

� keep in mind that sometimes you want to

� run qmake by right-clicking root-element of a project-tree and select-
ing Ru n qmake

� and then selecting Rebuild

5.5 Add- Ons

This section contains a few useful add-ons. Install them at your own discretion.
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-

Figure 5.3: Compiler-, Debugger-, and Kit-Settings in Qt Creator 4.7

5.5.1 Syntax Highlighting for M68000 Assembly

This is really handy if you often work with M68000 assembly �les in Qt Creator.
Get asm-m68k.xml and install it. The documentation of Generic Highlighting in
Qt Creator, as described in http://doc.qt.io/qtcreator/creator-highlighting.html
should serve you as a basis. On my machine, I just copied the �le to the
Fal lback Location (here: C:\QtSdk\Tools\QtCreator\share\qtcreator\generic-
highlighter).

5.5.2 Qt Plug-In for Visual Studio

If you'd like to use our supplied Qt Creator Project �les (*.pro) from within
Visual Studio, you can install the Qt Visual S tud io Tools as described in this
blog-postand provided here(for 2015) and here(for 2017). You can also install
it via the marketplace of Visual Studio.
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Once installed:

1. Select menu Qt VS Tools-> Qt Options

(a) add your Qt version

i. the name is automatically provided

ii. just select the path that leads to /bin/qmake under c:\Qt

iii. this only works for Qt5 and up

2. Select menu Qt VS Tools->Open Qt Project F ile (.pro)...

3. Build & Run

Please note that our IDE of choice is Qt Creator, so if you run into problems
with Visual Studio, we would be more happy to hear about your solutions, and
less prepared to help you �x it.

5.5.3 Symb ol Files

Even though you have already installed a lot of data, the symbol �les have not
been part of it. They would usually be loaded on demand over the Internet
connection and then cached locally. If you want to prepare yourself for longer
times without Internet, get the symbol �les. You can read more about this topic
in this article. We also have a direct download link somewhere and will add it
here at some point.
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Part I I

Demomaking

6 Single E xamples

This chapter takes you through the provided examples in order of complexity.

6.1 Hello World

Let's start with a simple hello world. We just want to build and run it from
within Qt Creator to con�rm that everything works.

6.1.1 Overview

� Open Qt Creator

� Select menu File -> Open File or Project ... (CTRL-O)

� Open hel loworld.pro from the /demo/hel loworld folder

� alternatively, you can also double-click on a project (*.pro) �le in
Windows Explorer

� Upon �rst start of a project in Qt Creator, select your previously con�g-
ured kit and press Con�gure Project

� Select menu Build -> Run (CTRL-R)

You should be presented with a console window and some printed text.

6.1.2 Discussion

It couldn't get much simpler than this. Basically, just a couple of printf()'s,
which require stdio.h. If compilation fails for you on that header �le, solve the
issue now, as described on page 39.

The example also shows the use of parameters that are provided to int
main(int argc, char **argv) , with argc being the argument count, argv[0] the
�lename, and argv[1..n] the supplied arguments, if argc >1.

Finally, the project also showcases the need for a shadow-build-subdirectory
(such as /build ), as Qt Creator calls qmake which creates its own �make�le�-
�le and thereby overwrites our existing �make�le� in GNU make syntax (9.1),
which we need to build for Amiga. All further examples will thus employ a
/build folder for the Amiga-speci�c build �les.

6.2 Stars

Just a classic star-�eld.
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Figure 6.1: Qt Creator session with project stars

6.2.1 Overview

� Open, con�gure, build and run stars.pro from the /demo/stars folder

You should be presented with a graphics window and some shaded 3D stars
�ying towards you, as show in �gure 6.1.

6.2.2 Discussion

This example does not load any external �les. The star�eld is set up and drawn
from a seperate �le called starse�ect.c (with �tting header starse�ect.h) which
is then called from main.c. Keeping the e�ect-code seperated like this is good
practice and will become very useful once we start putting together a demo.

Let's study the code in �gure 6.1starting from main():

� initDemo() is called �rst thing

� this declares screensize global variables xres=320 and yres=180

� it allocates memory for a screenBu�er (also global variable)

� and calls starsInit()

� this is obviously our e�ect init-code

� made known via #include �starse�ect. h� in line 2

� starsInit() is not entirely shown in the �gure

� it calculates quasi random 3D star-coordinates

� and calculates a palette
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� wosInit() is called next

� this sets up the graphics display amongst other things, and might
potentially disable multi-tasking on the Amiga (depending in wether
or not wickedquicklink.s / wickedlink.s have been assembled with or
without the KILLER �ag.)

� wosInit() does not immediately return, but

� hands over control to mainDemo()

� only returns to main() once the demo is over

� mainDemo()

� wosSetMode(8, screenBu�er, starsPalette(), 256);

� sets up a low-res 320x180 screenmode (#8)

� fed from screenBu�er

� with colours from starsPalette() at normal brigthness (256)

� on Amiga

� mainDemo() then loops over drawDemo(), providing time as
ticks (1/50 s)

� until wosCheckExit() returns !=0

� on PC (WIN32)

� mainDemo() immediately returns

� and drawDemo(time) is called from somewhere else from Qt

� (this is why there is this #ifndef WIN32 [..] #endif block)

� drawDemo() just

� renders the stars e�ect based on the given time

� updated the display with wosDisplay(2);

� the 2 denotes a lock to 25 fps maximum

� which is realistic for low-res chunky to planar e�ects on AGA/060
con�g

� motion will look smoother at a constant framerate rather than a
slightly faster on

� you could try (1) for a maximum 50 fps frame-lock or (0) for no
lock

� starsRender()

� clears the screenBu�er

� calls starsDraw(), with

� time

� 32 as a constant factor for the perspective
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� screenbu�er, xres, yres

� starsDraw() �nally

� iterates over the number of stars (7000)

� and for each star

� apply z-movement based on time with boolean clipping

� project x/y based on a �oating point perspective factor derived
from 1/z *variable factor

� determines a pixel-colour based on z

� adds that colour to the screenbu�er if the pixel is inside the x/y/z
box

� upon exit, deinitDemo() is called, which

� calls starsRelease() - an empty function/stub

� frees the tempBu�er that contained the screenBu�er and some safety
margin

The resulting e�ect is a classic, albeit simple star�eld. It doesn't rotate or even
just move in di�erent directions. All of this could be added, if needs be. But we
recommend you to go on and just take this as an example of a typical project
setup.

6.2.3 Compile for and run on Amiga

If you now wanted to compile the stars for Amiga, you would:

� open a console window on PC

� cd to the /stars/build folder

� run make

And then to run it on the Amiga, you would:

� cd to the /stars folder on Amiga

� run build/stars

For this simple project, which doesn't load any external data-�les, you could
actually also run it from the build folder. But as soon as you want to load data
(which we put in /data by convention), you would need to make sure you run
your executables from the right folder.

6.3 Picture

This example loads in and displays a picture that has been written in the stan-
dard GIF �le-format.
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6.3.1 Overview

� Open, con�gure, build and run picture.pro from the /demo/picture folder

� You should be presented with a picture in 320x180 resolution and 8-bit
colour-depth

Figure 6.2: Picture project (artwork by Helge/Haujobb)

6.3.2 Discussion

The e�ect simply loads a picture in GIF-format which can be created with
standard tools like Photoshop or Pro Motion. This is a lot easier and less
time-consuming than always employing a graphics converter program.

void pictureEf fectInit() {

int w,h;

gifLoad("d ata/helge-haujobb.gi f", (void**)&picture, &w,&h ,

(unsigned int* )&picturepal);

g_currentP al = pi cturepal;

}

The control �ow of this example is the same as in the previous example stars. So
upon init, the pictureE�ectInit() function is called, which calls gifLoad() with

� the �lename

� a pointer (&picture) to where the pointer to the loaded and decoded pic-
ture should be stored

� note that GIF is an 8-bit format with up to 256 colours

� picture is thus de�ned as unsigned char*
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� pointers to the int variables w & h which will store width and height of
the decoded image

� a pointer to an array of 256 unsigned int to store the image palette

Finally, pictureE�ectInit() also copies the pointer to the loaded image palette
to g_currentPal, which can be accessed from main.c in function drawDemo().
Here, the palette brightness will be calculated with a simple time-based function
that makes the image fade in and out smoothly on a sine-wave. Note that the
standard brightness for paletted image is 256. In this example it is just going
slightly above that for an exaggerated e�ect.

6.3.3 Changing the palette

If you run this example on the Amiga (like the stars example), you will notice
that the background colour around the image is not black and thus also fades
in and out. This is often not the desired e�ect. To �x it, we need to have look
at the palette.

Figure 6.3: Sorting the picture palette with the Pro Motion NG palette editor

Tools like Photoshop are very good for all sorts of image manipulations and
can also be used to save in the GIF-format. But it does not sort the colours in
the way we would prefer it, i.e. keep colour 0 dark. Photoshops' palette editor
is also below standard. Thus we will use a di�erent PC-based tool to �ddle with
the palette: Pro Motion N G from https://www.cosmigo.com/. The available
free version is enough for this excercise. So download and install it, then:

� Open the image �data/helge-haujobb.gif� by selecting menu File -> Load
Image ...

� You should see the image and the palette-editor (as in 6.3, left).

� If not, press F12 to open it.

� Now press the Fun cti ons button in the palette editor and select Sort ->
Brightness .
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� Ok, so the colors are sorted now, but from brightest to darkest. Your
palette should look like in 6.3, middle.

� But the image still looks odd.

� Press the Remap button in the palette editor, or select menu Colors ->
Resample (!) Co lor

� To have then have the palette sorted from darkest to brightest we have to
use �ip function now (Fun ctio ns -> Flip ).

� Your palette should look like in 6.3, right, as desired.

� Press Remap , again.

You can save the image, reload the Amiga executable without compiling it again,
and the border should stay dark.

6.4 Movetable

This example shows a typical movetable e�ect in 320x180 pixel resolution and
8-bit colour-depth.

6.4.1 Overview

� Open, con�gure, build and run movetable.pro from the /demo/movetable
folder

� You should be presented with an e�ect in 320x180 resolution and 8-bit
colour-depth

Figure 6.4: Movetable e�ect and underlying texture (texture by JCS/Haujobb)
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6.4.2 Discussion

The e�ect uses a texture of size 256x256 which is loaded from a GIF �le, like
in the previous example. Furthermore, it uses a movetable which is generated
using trigonometric functions and �nally uses those two components to build the
screen by obtaining per pixel texture coordinates from the movetable, moved by
a smoothly animated x- and y-o�set on a sine-wave. The movetable is exactly
twice the size of the screen, so 640x360 in this case, and represents a tunnel
shape. Other shapes are possible. Let's look at some details.

void movetable Init() {

int tabsize; int w,h ;

gifLoad("d ata/texture.gif", (void **)&texture, &w,&h,

(unsigned int* )&texturepal);

// provide 256x25 6x8 tga-file and test this

//tgaLoad8 ("data/texture.tga" , (v oid**)&texture, &w,&h,

(unsigned int* )&texturepal);

g_currentP al = te xturepal;

// allocate memor y

tabsize= tabx *taby;

// table size

xtab= (char*) malloc(tabsize);

ytab= (char*) malloc(tabsize);

// build tables

//buildSph ere(xtab, ytab);

//buildWat er(xtab, ytab);

buildTunne l(xtab, ytab);

}

If you look at function moveTableInit() from movetablee�ect.c you will see how
the texture is loaded and the function to build the table is called.

Just after the gifLoad() function is a tgaLoad8() function with the same
signature, which loads the Targa Image File format TGA. Targa is supported
by Photoshop and other tools. It is usually uncompressed and loads faster than
GIF. The bigger �le-size of TGA is compressed away when you bundle your
demo in a compressed archive. Furthermore, Targa �les also support higher
colour depths; a feature that will come in handy when you work with true
colour screenmodes. As an exercise, you could:

� provide a �le called texture.tga in 256x256 pixel size and 8-bit colour depth

� comment out the gifLoad() line and comment in the tgaLoad8() line

� the e�ect should work as before

moveTableInit() then allocates some memory and calls buildTunnel(), one of
three supplied build-functions, to �ll that memory with movetable data.
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� Try out the other two!

7 Demo E xa mple

This chapter pulls all the strings together and provides a complete example
demo that comprises of the previously discussed component with some added
streaming music. The e�ects' parameters are controlled via the excellent Rocket
sync-tracker. Although this approach to demo-syncing is quite common in the
PC-scene for many years, it is still fairly unknown in the Amiga-scene and only
used by very few demo-makers, like e.g. Loonies. In Haujobb, we have started
using Rocket when developing the Beam Ridersdemo. We have previously spo-
ken about our demo-making process in our Evoke 2018 talk Modern Amiga
Demo Cross-Development (YouTube). With the release of our Amiga demo
framework, we are now publicly sharing a complete and documented example
of how to sync your Amiga demos with Rocket. This is how we did it. And now
you can do it, too!

7.1 Hello Demo

7.1.1 Overview

� Open, con�gure, build and run hel lodemo.pro from the /demo/hel lodemo
folder

� The demo will refuse to start with the error message: �Could not connect
to rocket editor!�

� This is because the source-code of hellodemo is con�gured

� to require the Rocket editor on the PC

� and to play the demo from the stored parameters on the Amiga.

7.1.2 SYN C_PLAYER

If you wanted to quickly check the example demo on the PC, you thus need to
con�gure the source-code to not require the Rocket editor on the PC. This is
done with the SYNC_PLAYER de�ne in line 1 of main.c. If it is de�ned, the
demo will load the *.rt �les from the /data directory and then play the demo
with those parameters. So uncomment that de�ne and run hellodemo again. It
should start and show several e�ects timed to some music by Mu�er.

When you are done with that, comment that de�ne-line out again, as you
usually would want to work in edit mode on PC.

Note: the Amiga build gets the SYNC_PLAYER de�ne injected via the
make�le (-DSYNC_PLAYER in CFLAGS, currently in line 40, c.f. section 2.1
in VBCC docs).
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7.1.3 Go o d Practice Track Names

Rocket track names are your interface to your demo. For a typical demo, you
will quickly have dozens of track names, so it is a Good Idea TM to name them
properly. They also need to operate within certain limits:

� keep names short, meaningful and lowercase

� all Rocket tracks are Floats by default

� but you can cast them e.g. to Int within your code

� Furthermore they are also saved to disk with �lenames comprising of a
certain scheme (we chose: sync_*.rt, where * is e�ectname_variablename,
e.g. sync_movetable(2)_time.rt) that will have to �t within the Amiga
Fast File System �lename-length limit of 30 chars.

From our own experience we can propose the following:

� part : should be used as an Int to keep track of the currently visible part

� brightness : Int for the current palette brightness (if applicable), 0 means
black, 256 is normal, >256 brighter

� e�ects should expose their name plus their part number in brackets, e.g.
movetable(2), as some kind of namespace

� e�ect variables are are appended to this namespace-name with a colon
(�:�)

� see the code from getSyncTracks() from main.c as an example

void getSyncTr acks() {

// rocket get tracks

// general

rt_part = sync_get _track(rocket, "part");

rt_brightne ss = sy nc_get_track(rocket, "b rightness");

// pictures

rt_picture_ id = sy nc_get_track(rocket, "p icture(0):id");

// stars

rt_star_tim e = syn c_get_track(rocket, "st ars(1):time");

rt_star_per s = syn c_get_track(rocket, "st ars(1):perspective") ;

// movetable

rt_move_tim e = syn c_get_track(rocket, "mo vetable(2):time");

rt_move_xta b = syn c_get_track(rocket, "mo vetable(2):xtab");

rt_move_yta b = syn c_get_track(rocket, "mo vetable(2):ytab");

}

Adhering to such a scheme will make your life easier when wiring up the internals
in your code and when timing your demo. So better stick to it.
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7.2 Ro cket Edit or

Rocket is is an in tu itive new way of... bah, whatever. It's a sync-tracker, a tool
for synchronizing music and visuals in demoscene produ ctio ns. It consists of
a GUI editor (using Qt), and an ANSI C library that can either commun icate
with the editor over a netw ork socket, or play back an exported data-set. � from
Rocket GitHub page.

To get started with using the Rocket editor, download the latest o�cial
binaries from the GitHub Rocket releases. The archives come readily bundled
with the required libraries, so just unpacking and starting editor.exe should
work. Since its inception, several ports of the Rocket editor have appeared. All
of them are listed on the Rocket GitHub page. We personally only worked with
the original editor, but also quickly tested the alternative OpenGL editor and
can con�rm that it works.

On Windows, the Windows �rewall would usually come up when starting
your chosen editor for the �rst time. Just allow it to pass, as the editor will
need to communicate with the demo via network.

Figure 7.1: Rocket editor (left) and hellodemo (right)

Once you started the editor, you can recompile (without SYNC_PLAYER
de�ned) and run the hellodemo project. You should immediately see some magic
happen in the editor. As the demo and the editor already communicated about
the available sync tracks, the editor should show them neatly organised in tabs,
here: default , picture(0) , stars(1) , movetable(2) . The sync tracks still have no
keyframes and interpolation methods assigned, yet. This is the typical state of
how you would start with a clean slate once you wired up your Rocket variables
in your code.

To get started with our example, load the provided �le hel lodemo.rocket

31

https://github.com/rocket/rocket
https://github.com/rocket/rocket/releases
https://github.com/rocket/rocket
https://github.com/emoon/rocket


from /data/hellodemo into your editor. This should populate the sync-tracks
with data (see �gure 7.1). You can now start and stop playing the demo by
pressing <SPACE> in the editor.

7.2.1 Using the Editor

Note: This section is copied from the o�cial Rocket documentation.
The Rocket editor is laid out like a music-tracker; tracks (or columns) and

rows. Each track represents a separate "variable" in the demo, over the entire
time-domain of the demo. Each row represents a speci�c point in time, and
consists of a set of key frames. The key frames are interpolated over time
according to their interpolation modes.

Interp olation mo des Each key frame has an interpolation mode associated
with it, and that interpolation mode is valid until the next key frame is reached.
The di�erent interpolation modes are the following:
Step : This is the simplest mode, and always returns the key's value.
Linear : This does a linear interpolation between the current and the next

key's values.
Smooth : This interpolates in a smooth fashion, the exact function is what

is usually called "smoothstep". Do not confuse this mode with splines; this only
interpolates smoothly between two di�erent values, it does not try to calculate
tangents or any such things.
Ramp : This is similar to "Linear", but additionally applies an exponentia-

tion of the interpolation factor.

Keyb oard shortcuts Some of the Rocket editor's features are available through
the menu and some keyboard shortcut. Here's a list of the supported keyboard
shortcuts:

7.3 Wiring up your variables to Ro cket

Wiring up your code's internal variables to Rocket so that they can be modi�ed
over the network connection with the Rocket editor is at the heart of working
with Rocket from a coder's perspective. It is a straight forward process that
you will quickly embrace once you know what needs to be done.

All of this is usually happening in your demo's main.c - the e�ects do not
know about Rocket at all. For the purpose of this write-up, we are just handling
the case of the stars e�ect. All other e�ects are handled in the same way and
you can follow everything in full detail in hellodemo's main.c.

7.3.1 Declarations

Include Rocket de�nitions from:

#include "../s hared/rocket/lib/syn c.h"
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Shortcuts Action

Up/Down/Left/Right Move cursor
PgUp/PgDn Move cursor 16 rows up/down
Home/End Move cursor to begining/end

Ctrl+Left/Right Move tracks
Enter Enter key frame values
Del Delete key frame
i Enumerate interpolation mode
k Toggle row-bookmark

Alt+PgUp/PgDn Go to prev/next row-bookmark
Space Pause/Resume demo

Shift+Up/Down/Left/Right Select
Ctrl+C Copy
Ctrl+V Paste
Ctrl+Z Undo

Shift+Ctrl+Z Redo
Ctrl-B Bias key frames

Shift+Ctrl+Up/Down Quick-bias by +/- 0.1
Ctrl+Up/Down Quick-bias by +/- 1

Ctrl+PgUp/PgDn Quick-bias by +/- 10
Shift+Ctrl+PgUp/PgDn Quick-bias by +/- 100

Table 2: Rocket editor shortcuts

For working with Rocket, you always need a sync_device :

struct sync_de vice *rocket;

You would then de�ne multiple sync_tracks , one for every variable that you
want to animate:

const struct sync_ track *rt_star_time;

const struct sync_ track *rt_star_pers;

Tracknames should start with �rt_�. It is suggested that you name them ac-
cording to their namespace and variable names, e.g. rt_part or rt_star_time.

7.3.2 sync_get_track()

Your internal sync_tracks are made known to the Rocket editor via the sync_get_track
function. Its invocation is also the place to provide the names that appear in
the editor and on disk for the saved tracks. In hellodemo's main.c this is all
done in getSyncTracks():

void getSyncTr acks() {

[..]

33



// stars

rt_star_ti me = sy nc_get_track(rocket, "st ars(1):time");

rt_star_pe rs = sy nc_get_track(rocket, "st ars(1):perspective") ;

[..]

}

Depending on the de�nition of SYNC_PLAYER, sync_get_tracks will either
connect to the editor, or try to load the tracks from disk.

7.3.3 sync_get_val()

Getting variables out of Rocket is done via the sync_get_val function. It takes
the desired trackname and row-position as input and returns a Float. The
calculation of row is based on the play-time of the music. Implementation
details can be found in drawDemo() and also in updateDemo().

The code snippet below shows how we get the variables for the stars e�ect:

void drawDemo( int time) {

[..]

int ri_star_ti me;

float rf_star_ pers;

[..]

// stars

ri_star_ti me = (i nt) sync_get_val(rt_star _time, row);

rf_star_pe rs = (f loat) sync_get_val(rt_st ar_pers, row);

[..]

}

As per our convention, variables from Rocket that hold:

� Float values (the default) should be preceeded with �rf_�

� Int values (requiring an explicit cast) should be preceeded with �ri_�

7.3.4 Passing variables to an e�ect

Once we have the time-based values for our variables from Rocket, we can feed
them to our e�ects. As written above, the e�ects to not know of Rocket. They
just need to get their parameters when calling their render-function. All e�ects
take the variable time as their �rst and most imporant parameter. They are
required to render a frame according to time .

The stars e�ect additionally takes a perpective factor as a parameter.

void starsEffe ctRender(int time, float persf ak);
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7.4 Common E�ect Functions

As previously implicitly covered (6.2.2), e�ects are expected to have typical
functions when working our way.

More explicitly, the minimum required functions when coding single e�ects
are:

void effectIni t();

void effectRen der(int time);

void effectRel ease();

unsigned int* effe ctPalette();

Init, Render and Release should be clear. The Palette function is required, as
the current palette will be used outside the scope of the e�ect, e.g. to support
setting the brightness.

To avoid name-clashes, it is good practice to preceed those names with the
actual e�ect name, e.g. starsE�ectInit().

When putting the e�ects together as a demo, you need one additonal func-
tion:

void effectOn( int startTime);

This is a very short function that basically sets the screenmode, palette and
dimensions (xres/yres) everytime an e�ect is called for the �rst time. This
is required because you will want to have di�erent e�ects that might run in
di�erent screen modes. Here is how the starsE�ectOn() function looks like:

void starsEffe ctOn(int startTime) {

starsEffect _startTime=startTime ;

xres=320;

yres=180;

wosSetMode( 8, screenBuffer, starsPalet te(), 0);

g_currentPa l = sta rsPalette();

}

The startTime is not always used, but always required by convention. xres
and yres in this example are for a typical 16:9 low-res screen. wosSetMode sets
up the display for that mode (see 10.2 for a list of available modes) to work
from that frame-bu�er screenBu�er and with the palette pointer obtained from
starsPalette() . The initial brightness is set to 0 (black). Finally, the palette
pointer is stored in the global variable g_currentPal .

7.5 Common Demo Functions

When putting your e�ects together as a demo, you would naturally call their
Init and Release functions from the respective functions in the demo's main.c
(here: initDemo and deinitDemo ). Actually, in hellodemo, the init-functions
are all grouped in another function called reloadDemo . This will become useful
later when starting to use the �le-watcher and auto-reload functionality.
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7.5.1 drawDemo()

Then, when it is time to draw a frame, the demo needs to �gure out which
e�ect (part) needs to be called, and if it had already been shown in the previous
frame. If not, the part has to be enabled. This is done like this:

int prevPart=- 1;

[..]

void drawDemo( int time) {

int curPart;

[..]

curPart = (int) sync_ get_val(rt_part, row);

// init part

if ( (prevPart != curPart ) | cur Part==0) {

switch (curPar t) {

case 0:

pictureEff ectOn(time); break;

case 1:

starsEffect On(time); break;

case 2:

movetableEf fectOn(time); break;

default: brea k;

};

}

When it is veri�ed that the part is enabled, it can be drawn like this:

[..]

// draw part

switch (curPar t) {

case 0:

pictureEff ectRender(ri_picture _id); break;

case 1:

starsEffec tRender(ri_star_time , rf _star_pers); break;

case 2:

movetableE ffectRender(ri_move_ time, ri_move_xtab, \

ri_move_yta b); break;

default: brea k;

};

Finally, at the end of the draw function, the prevPart variable it prepared for
the next frame, and the current frame is displayed.

prevPart = curPart ;

wosDisplay (2);
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wosDisplay triggers the chunky to planar conversion, i.e. the conversion of
the byte-chunked screenBu�er (of 8 bit colour depth, as set previously with
wosSetMode) into 8 seperate bitplanes to be displayed by the Amiga AGA
chipset. Due to the slow speed of the chip memory, the Amiga will spend almost
an entire frame for this conversion in a typical low-res resolution. It is generally
unrealistic to expect to be able to draw 50 frames per second (FPS). Depending
on the e�ect complexity, the target hardware, and the frame's content, you
would often be able to reach a framerate in the range of 25 to 40 frames per
second. But a stable motion at a �xed framerate looks smoother than one with
varying framerate. Therefore, wosDisplay takes a frame-lock parameter:

� 0 : no frame-lock, i.e. run as fast as possible (possible faster than 50 FPS
in very low resolutions)

� 1 : frame-lock to every frame, i.e. 50 FPS max

� 2 : frame-lock to every other frame, i.e. 25 FPS max

While 50 FPS can be achieved with some 160x90 screenmodes, you would gen-
erally want to aim for 25 FPS with low-res 320x180 screenmodes.

7.5.2 up dateDemo()

While most screenmodes will not update in every frame, there is a possibilty to
run certain parts of the code at 50 FPS intervals by putting it in the provided
updateDemo function. This is triggered by the vertical blank interrupt (VBI)
from assemly-bridge.s and can be used for making quick changes, e.g. to the
colour palette when fading.
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Part I I I

Annex

8 Credits

8.1 Framework

The Haujobb Amiga Framework has been developed by Hell�re and Noname.

� low-level hardware API WickedOS by Noname

� high-level PC API counterpart WO S Qt by Hell�re

� standard code in /shared by Hell�re

� examples by Noname and Hell�re

� documentation by Noname

8.2 Third party co de

Standing on the shoulders of giants. With little modi�cations here and there.

� system-friendly hardware startup by Piru

� system-friendly interrupt example by Comrade J

� Kickstart v39 sprites �x by Comrade J

� Speedychip by Piru

� C2P routines by Kalms

� partially modi�ed with inline-saturation code based on an idea from
Blueberry by Hell�re and Noname

� Further WickedOS components (currently not exposed through API)

� Tracker Packer 3 by Crazy Crack

� The Player 6.1 by Guru

� old AHX/THX by Dexter

� AHX by Dexter

� Pro�ler by Bartman

� CRM decruncher by Thomas Schwarz

� ADPCM player in Hello Demo by Kalms (Amiga) and Ian Luck (PC)

� Rocket sync-tracker and library by Kusma et al.
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8.3 Artwork

How would life be without artists? The following pieces have been bundled with
the release of our framework:

� picture Haujobb Forever by Helge

� picture An droi ds Dream by Acryl

� movetable texture by JCS

� music in Hello Demo by Mu�er

9 Trouble-Sho oting

9.1 Missing Standard Headers

With Visual Studio Community 2017 we have witnessed missing standard head-
ers, resulting in compilation problems even for the simplest programs such as
the hello world (6.1).Unbelievable as it sounds, this behavior is also documented
on Stack Over�ow, along with the solution in answer #1.

To solve this problem, you need to rerun the Visual Studio Installer and se-
lect Windows Universal CRT SDK under Individual Components -> Compiler,
Buildtools and Runtimes. Then restart you IDE, and rebuild your project.

10 WickedOS

This is a collection of notes about the WickedOS-layer of our Amiga Framework.
Normally, you should not need to study this, but you are very welcome to.

10.1 Built-In Test

If you are feeling nostalgic or curious, you can assembly and run a built-in ex-
ample of WickedOS in ASM-One or Devpac on the Amiga! The visual outcome
will be the same as that described in section 2.3 on page 7.Of course, it doesn't
matter if you are using real or emulated hardware for this.

10.1.1 With ASM-One

If you coded on Amiga before, chances are that ASM-One is already installed
and that you know how to use it. The minimum supported version is 1.29. If
you do not have at least this one, just either:

� download ASM-One from http://aminet.net/package/dev/asm/ASM-One,

� or get ASM-Pro from http://aminet.net/package/dev/asm/AsmPro1.18src,
which is an improved and open-sourced version
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� or grab my copy of ASM-One v1.29.

Set the WOS: Assign before you start ASM-One.

1. assign �WOS:� to where you unpacked WickedOS

2. list WOS:wos_v#? (should list the main �le, currently v1.62)

3. Consider putting the assign from line 1 into s:user-startup (optional)

Then test WickedOS' built-in example AGA-screen from within ASM-One.

1. Start ASM-One from a Shell (This is important, as starting it from an
icon will cause you a lot of trouble, as previously discussed on Amiga
Demoscene Archive.)

2. Give it some public memory

(a) ALLOCATE Fast/Chip/Publ/Abs>p

(b) WORKSPACE (Max. XXXXX) KB>1000

(c) Note: ASM-One from Aminet (v1.48) seems to expect an assign
�Sources:� at startup. If you don't have it, either:

i. assign �Sources:� to somewhere useful, or just to �Ram:� for
testing

ii. or in Asm-One go to Preferences->Environment and change �De-
fault Dir:� textbox value to an existing directory or empty it

iii. or restart Asm-One with �!� to get the memory prompts again.

3. Menu->Assembler->Preferences->Assembler

(a) CPU 68020

(b) Check �FPU Present�

(c) Uncheck �UCase = LCase�

(d) Uncheck �; Comment�

(e) Press �Save�

4. Type �v wos:� (to set the working dir)

(a) v (to list the dir, just to con�rm and refresh your memory)

5. Type �r� (read) and select the latest version of wos:wos_v#?.s

6. Press <ESC> to get into edit-mode

(a) Remove the �;� before WTEST in line 3

(b) Press <ESC> again to go back into command line mode (�>�)
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7. Type �a� (assemble), and ASM-One will assemble your source.

8. Type �j� (jump), and you should see a nice picture and listening to a tune.
(If it didn't work, you might not have AGA, 68020+ and FPU in your
machine. Please note that WickedOS does not strictly require neither
AGA nor an FPU, but this con�guration is the baseline for the AGA/060
demos that we want to build with it.)

10.1.2 With Devpac

Devpac was probably the best allround commercial assembler development pack-
age for the Amiga. If you want to give it a go, either use your existing instal-
lation or get a copy from the English Amiga Board �le server (�les �Devpac
v3.04#?.adf� in /Commodore_Amiga/App/Disk/).

Once installed:

1. Project->Load the WickedOS main-�le wos_v1.#?.s

2. Remove the �;� before WTEST in line 3

3. Settings->Assembler->Options

(a) Processor: 68020

(b) Check �68881/2 Maths Coprocessor�

4. Program->Assemble

5. Program->Run

Check the manual to learn about hotkeys, and the really powerful debugger
�monam�. The manual is available at https://computerarchive.org/, which host
lots of other Amiga manuals, too, in /�les/comp/applications/amiga/manual.

10.1.3 Recap

You tested that the supplied WickedOS-sources directly assemble and work
on the minimum supported assembler, ASM-One (without using intermediate
object-�les and linking). This provides the ground for the following steps with
vasm and vlink.

If you were planning to make extensive use of WickedOS with ASM-One or
Devpac on Amiga, you might be interested in setting the WOSASSIGN-�ag.
This would allow you to set your working directory to somewhere else and then
just include WickedOS from wos:newestwos.s, which would then �nd all of its
�les from the WOS: assign.

But even if you don't plan to use ASM-One, you must at least provide the
assign to INCLUDES: if you plan to assemble WickedOS on Amiga.

10.2 List of Screenmo des

todo

41

http://eab.abime.net/showthread.php%3Ft%3D43633
https://computerarchive.org/files/comp/applications/amiga/manual/Devpac%203%20-%20Manual-ENG.pdf
https://computerarchive.org/
https://computerarchive.org/files/comp/applications/amiga/manual/


10.3 How t o add a new screenmo de

Adding a new C2P-based screenmode to WickedOS requires a few modi�cations
at several places in several �les. As I tend to forget at least one place for myself,
this write-up is at least for my own reference.

Hint: you can set wtest �ag in the main wos_v#?.s source for setup and
display a simple screen. Note: XY is to be replaced with a running number,
e.g. 19

in �le wos# ?.s

1. in _wosbase:

(a) mXY: dc.l 0,0,0,0 ; add some comments as well

2. in WOSInit:

(a) add an init block for your c2p-mode after the last one (.m18ok at the
time of writing)

ifnd NOMODEXY

lea mXYc2p,a0

lea mXY,a1 ;dc.l 0,0, 0

move.l a0,(a1) + ;I nit

add.l #4,a0

move.l a0,(a1) + ;M ain

add.l #4,a0

move.l a0,(a1) + ;E xit

endc .m7ok:; feel fre e to ad d cu stom init code here

; e.g. generation of ham mas ks o r t he l ike

3. in _Display:

(a) add macro-line "_DisplayM1 XY" in �rst block

(b) add macro-line "_DisplayM2 XY" in second block

4. in _RefreshDisplay:

(a) "add cmp.b #XY,d0" and "beq .mXY"

(b) provide �tting code at .mXY (copy from appropriate 8 bit or ham-
based examples above)

5. in SetModeAndColors:

(a) add macro-line "_SetMaCM1 XY" in �rst block

(b) add macro-line "_SetMaCM2 XY" in second block

(c) (for ham-modes) add special cmp/beq cases at ".m0"
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6. in _SetMode:

(a) add macro-line "_CallSetModeMac XY" in �rst block

(b) add macro-line "_SetModeMac XY" in second block

7. in _SetColors:

(a) add macro-line "_SetColM1 XY" in �rst block

(b) add macro-line "_SetColM2 XY" in second block

8. in Modes:

(a) provide �tting block which adds exactly one bit to MODES (double
the number of the previous) e.g.

ifnd NOMODE18

MODES set MODES!1 31072

endc

i. (this bitwise-logic is why there are currently a maximum of 32
modes supported)

(b) include you binary code and provide label mXYc2p

i. (code is expected to have jump table like all the other modes -
init at 0, c2p at 4, etc..)

in �le sub/wos_de�nes.i

1. in struct after "De�ne the structure" comment

(a) add four rs.l 1 entries to structure for modeXYinit, modeXYc2p,
modeXYexit, modeXYptr

2. after "Set up the screen-dimensions" comment

(a) provide �tting MakeMode line to describe your screen dimensions

(b) (or alternative de�nitions of modeXYsize .. modeXYsize)

in �le sub/wos_copp erlists_v#?.s

1. at EOF

(a) provide �tting copperlist named CopmXY, also with labels sprmXY
and colmXY with appropriate space

in dir sub/chunky/sources

1. Finally you need to provide a �tting c2p-routine as a PC-relative plugin.
Check the provide sources and do likewise.

(a) name the �le as "mode#?.s"
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in �le sub/chunky/sources/make�le

1. add �lename to Sources

Schematic Overview

To do:

� Advanced Framework Functions

� pro�ler

� �le-watcher

� cache simulator

� palette tool

� run

� visual studio command prompt

� �nmake install� to get the required libraries to the folder

� mixasm

� ace make all

� Audio, getting your music in
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� music dependencies

� rocket_bpm

� rocket_rpb

� rocket_row_rate

� stream player

� bass on PC

� Kalms ADPCM on Amiga

� Audio ADPCM Saving and determining BPM

� Screenmodes

� list of

� example

� Literature

� https://www.doc.ic.ac.uk/lab/cplus/cstyle.html
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